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Abstract       Field study in the logging yard by modern methods leads to 
increased precision in design, as well as better planning of it by representing 
all activities on digital maps. 

 Field study using specialized software involves first obtaining digital 
map of the forestry yard or area where it is located and overlay over 
GoogleEarth satellite images. 

 With this digital map superimposed over GoogleEarth satellite 
images, or other G.I.S. specialized software, it is necessary to draw polygon 
boundaries representing logging yard, homogeneous surfaces etc. Below is 
presented the calculation of dimensional characteristics of these polygons. 

 This essay continues with determination and representation of 
homogeneous surfaces flow directions and then by tracing ways of collecting 
and calculating their length. To determine distances to collect wooden work, it 
is shown how to calculate distances from the centers of gravity of 
homogeneous surfaces to the collection routes and the establishment of focal 
points of concentration of wood and  woodpiles. 
 The end result of a land survey in a logging yard is the forestry yard 
sketch. Represented digitally in G.I.S., forestry yard design provides to the 
user all geomorphologic and dimensional details of all technical features of 
the logging yard.   
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Land survey is the most important step in the 

design activity logging wood operations. This study is 

due to the fact that the land survey connects the reality 

on the ground and design work in the office. 

 Large volume of subject areas from logging 

wood operations involves a lot of work in the design 

activities of these works. 

 The aim of the field study in a logging yard 

with modern means is none other than to facilitate the 

work of the designer, making it more expedient, but 

also of keeping or even raise the standards of precision. 

  Land study with modern means involves the 

same steps as the classic study of the land, but the land 

is transferred in stages by working in G.I.S. office. 

  Satellite images of logging yard allow us to 

analyze the situation in the field as a whole. We can see 

the possible existence of collection route that we can 

use. Still using satellite images we can analyze in 3D 

mode the relief from forestry yard and we can give 

optimal solutions for collection routes or choosing the 

homogeneous surfaces. 

    The expeditious and simplicity way of 

working by modern study comes from the fact that, any 

feature of logging yard, once represented in G.I.S. 

(GoogleEarth in our case) is accompanied by 

dimensional details by displaying or calculating them. 

 

Materials and Methods 
 

Obtaining digital map 

 

The first step in the study of the land with 

specialized software is to obtain digital maps. Thus, at 

this stage can be two situations, one in which we 

provide a digital map of the U.P.'s and another one in 

which we have available a physical map. 

If we provide a digital map of the U.P.'s that it 

is opened with ArcReader and its content is necessary 

to seek u.a. that contains the logging yard. U.a identify 

and Zoom In function in the ArcReader, all u.a. fit on 

the screen, so u.a. should be represented on a scale as 

high as possible. 

On the File menu is accessed Export Map 

command with which the screenshot is saved in .bmp 

file extension. 

If that is not available a digital map coordinate that 

is superimposed over the map in GoogleEarth land, 

proceed to scan a sector of U.P.'s general map covering 

the forestry yard service. 
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Overlapping digital maps 

 

Overlap in GoogleEarth maps obtained as 

described above differs in the two cases. 

If we have a digital map it we can access it 

using ArcReader software or other specialized 

software. Leading the pointer in the four corners of the 

digital map represented in ArcReader, we get the 

coordinates of corners Stereo 70 image that we saved, 

necessary for the WGS84 coordinate in GoogleEarth. 

We read the coordinates from the Status Bar in 

ArcReader and note them. 

 

 

 
 

Fig. 1 Reading coordinates in ArcReader 

 

The transformation of these Stereo 70 coordinates 

in WGS84 coordinates can be done using TransDatRO 

program, version 4.01. 

To load the map in GoogleEarth we must follow 

the path below: 

 

Add  Image Overlay  Location  Convert To 

LatLonQuad 

 

In the opened window in GoogleEarth, we enter 

the transformed coordinates by Stereo 70 coordinates 

in WGS84 coordinate, using TransDatRO program 

version 4.01. 

It should be noted that the 1
st
 corner is the bottom 

left corner of the image saved, next corners respecting 

the trigonometrical direction. The loading map will be 

automatically superimposed over the map in Google 

Earth’s terrain. 

 

 
Fig. 2 Overlapping digital map in GoogleEarth 
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If we have a scanned map, it will be superimposed 

on GoogleEarth, taking into account at least 3 points 

on the scanned map (confluence of streams, roads, 

cities  etc.), identified in GoogleEarth. These points 

will be evidenced in GoogleEarth by Add  

Placemark and according to them, by direct probing, 

the scanned map will be superimposed on the map of 

the land, adjusting The transparency map overlay. 

Dupa punerea planului în coordonate compatibile 

GoogleEarth (WGS84), acesta se importă în 

GoogleEarth cu opţiunea Image Overlay din meniul 

Add. 

After putting the plan in GoogleEarth compatible 

coordinates (WGS84), this is imported in GoogleEarth 

with Image Overlay option in the Add menu. 

 

Creating polygons corresponding the logging yard, 

homogeneous surfaces 

 

To create polygons representing logging yard, 

homogeneous surfaces, it is necessary to create in the 

left sidebar menu, a new folder for saving polygons 

which is to be created. 

After opening the Polygon option from Add menu 

it is operating the forestry limit, then it saves the  

obtained polygon under a name chosen by the user.

 

 

 
Fig. 3 Demarcation of logging yard 

 

The operation is repeated for designing each 

homogeneous surfaces. 

Via a right click on each polygon saved, whether it 

is the logging yard, homogeneous surfaces, 

regeneration area, from  Properties menu you can set 

the color, transparency, the name of each polygon 

saved. 

With specific functions of GoogleEarth it will be 

represented and determined in G.I.S. all other technical 

characteristics of the forestry yard: homogenous areas, 

centers of gravity of the surface homogeneous, flow 

directions of homogeneous surfaces, collection routes, 

the woodpiles. With the representation and exploitation 

logging features above, all represented in G.I.S. they 

will provide the complete sketch of the logging yard. 

 

 

 

 

 

 

Results 
 

Homogeneous surface area calculation and 

determination of centers of gravity 

 

Reprezentarea în Google Earth se face accesând 

butonul View on Google Earth. În calculator va fi 

salvat un fisier care va contine toate datele necesare 

reprezentării.  

To calculate surface areas homogeneous, the folder 

containing saved polygons will be copied to the 

corresponding calculation window surfaces from the 

site http://earthpoint.us   

Output options are chosen, usually using grades as 

a measure for coordinated hectares for area and meters 

for distance. 

Press the View On Web Page to view the results. 

Representation in GoogleEarth it is accessing 

View on Google Earth button. In the computer it will 

be saved a file that will contain all necessary data 

representation.

 

 

http://earthpoint.us/
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Fig. 4 Calculation of homogeneous surface area 

 

The access to this file will cause in GoogleEarth 

representation of the points covered and the center of 

gravity for each polynomial. 

The center of gravity of homogeneous surfaces it 

is of particular interest for the design of logging. 

The representation of each point can be enabled or 

disabled from the left sidebar menu. 

 

 

 
 

Fig. 5 Representation of the homogeneous areas and centers of gravity 

 

To store data in format .xls we access Export to 

Excell button, and so the data will be saved in .xls file 

extension. 

Thus, after following limits u.a. 47 A and 

homogeneous surfaces, we obtain data on the areas 

covered, data presented in the table below and 

represented in the form in which they are stored by the 

option Export to Excell.
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Table 1 

Area and the number of points 

on the contour polygons 

 

Name Shape Type 
Number 

of Points 

Area 

(Hectares) 

enclava Polygon 50 0.4899 

u.a. Polygon 90 26.8186 

SO1 Polygon 27 4.8449 

SO2 Polygon 27 2.8981 

SO3 Polygon 20 3.9057 

SO4 Polygon 16 2.9710 

SO5 Polygon 29 2.8330 

SO6 Polygon 9 1.2744 

SO7 Polygon 13 1.3204 

SO8 Polygon 16 2.6690 

SO9 Polygon 19 2.1768 

SO10 Polygon 16 1.7666 

 

Determination and representation of homogeneous 

surface flow directions 

 

By means of the navigation button within 

GoogleEarth compass on the top right of the screen, it 

operates the leaning land surface, facilitating 

observation of flow direction of each homogeneous 

surfaces.

 

 

 
 

Fig. 6 Observation the flow directions of homogeneous surfaces 

 

Inside each homogeneous area will be drawn with 

the option Tools  Ruler Line, a line in the direction 

of greatest flank, line passing through the center of 

gravity of each homogeneous surfaces.
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Fig. 7 Drawing the flow directions of homogeneous surfaces 

 

Flow directions will be saved in a folder better 

called "flow direction". 

By means of Show Elevation Profile option from 

the displayed menu after the execution right click on 

the icon representing flow direction, will be displayed 

the ground profile along the saved route, the view 

height and slope at each point.

 

 

 
 

Fig. 8 Land profile along a route 

 

This option can be used when choosing the 

direction of the greatest slope in the collection routes 

study, especially in the determination of homogeneous 

surfaces. 

 

Drawing the collection routes and determinating 

their length 

 

Drawing the collection routes is based on 

homogeneous surfaces, using Tools  Ruler Path 

option. Collection routes drawn are saved in a folder 

called "collection routes". 

Accessing the collection routes profile is as if flow 

direction. 

The length of each collection routes can be read 

from the chart representing the collection routes 

profile, and also making right click on each collection 

routes from the folder where they were saved in 

GoogleEarth menu and following the path Properties 

 Measurements. The length of collection routes of 

this logging yard are represented in the following table.
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Table 2 

Length of collection routes 

 

Collection routes Routes length (m) 

1 704 

2 815 

3 372 

4 127 

5 760 

 

Calculating the distance between the centre of 

gravity of homogeneous surfaces and collection 

routes 
 

Calculating the distance between the centre of 

gravity of each homogeneous surfaces and collection 

routes will be made for each homogeneous area in the 

flow direction using the tool Tools  Ruler.

 

 

 

 

 

Fig. 9 Determination of the distance between the center of gravity and collection routes of homogeneous surface 

 

The distances calculated will be saved in a folder 

and will be called homogeneous surfaces properly. So, 

for homogenous area in the image above, the land 

distance between the center of gravity of the 

homogeneous area and collection routes in the flow 

direction of homogeneous surface is 69.89 m, similarly 

for the other homogeneous surfaces. 

 

 

Establishment of the woodpiles 

 
The woodpiles will be on the base on 

homogeneous surfaces, in the direction of flow, in 

relation to the center of gravity. 

Their representation in GoogleEarth can be done 

using the representation function of the points Add  

Placemark.
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Fig. 10 Representation of the woodpiles 

  

            

In the same way will be the representation of the 

primary platform in the logging yard base, too. 

 

The complete sketch of the logging yard 

 

The image below shows the complete sketch of the 

logging yard, completed with the details shown above. 

That is the map of u.a. 47A arrangement, 

homogeneous surfaces, centers of gravity of 

homogeneous surfaces, flow directions, collection 

routes, woodpiles and primary platform and also the 

distances between the centers of gravity of 

homogeneous area and woodpiles, each of it is possible 

to access the dimensional characteristics and their 

position required for the field picket and transposition 

of the forestry operations in u.a. 47 A.

 

 

 
 

Fig. 11 The complete sketch of the logging yard 

 

Conclusions 
 

 Field study by modern methods, using G.I.S. 

system for representation and determination of 

dimensional characteristics of the main elements of the 

logging yard makes the land survey activity to be more 

expeditious and accurate than the classic system. 

 The expeditious method presented comes from the 

fact that the design of the collection routes and all 

logging yard elements is performed simultaneously 
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with their dimensional characterization and with the 

preparation of logging sketch. 

 The analysis of the satellite images allows the 

analysis of the overall logging yard operating, the 

existence and possible use in operating activities of 

existing routes. 

 Observation of Google Earth land in 3D mode 

allows to analyze the position and size of different 

landforms and positioning of all elements towards 

primary platform and forest route that will be 

transported wood. 

 The software used in this study is free which 

means that this method is available to designers and 

more. 

 Working with software dedicated to such activities 

will allow the implementation described in the present 

article in a simpler manner and probably with better 

results. 
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